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OVERVIEW
How much do you really know your way around Photoshop type 
tools and panels? Join Khara Plicanic on this fun and playful 
typographic adventure, and discover techniques for building 
creative type treatments and customizations while learning how 
to think differently about — and get the most from — your 
fonts. 

You’ll learn:

* Creative techniques for working with text

* Advanced typographic features that may surprise you

* What to look for in a professional font 

* How to access thousands with your Creative Cloud 
membership

FILES & FONTS
To license the free practice files from Adobe Stock, follow these 
links and log in with your Adobe ID:

* Adobe Stock File #246801380

* Adobe Stock File #349135830

* Adobe Stock File #305678866

* Adobe Stock File  #475612179

 
Activate the following fonts from Adobe Fonts (free with your 
CC subscription):

* Marydale

* Salvation

* Filicudi (the entire collection)

* Looking Flowers (all three)

https://stock.adobe.com/images/texture-of-a-universal-soil-with-mineral-fertilizers-for-planting-flowers-and-plants/246801380
https://stock.adobe.com/images/gardening-background-with-garden-tolls/349135830
https://stock.adobe.com/images/paper-cup-and-coffee-beans-on-cement-floor-background/305678866
https://stock.adobe.com/images/black-cat-sitting-at-chair-with-hanging-face-patterned-towel/475612179
https://fonts.adobe.com/fonts/marydale
https://fonts.adobe.com/fonts/salvation
https://fonts.adobe.com/fonts/tipoteca-series
https://fonts.adobe.com/fonts/looking-flowers


Khara Plicanic has taught more than 50 courses and published 
several books on everything from the basics of  photography and 
software applications to business strategy and workflow.

A Photoshop nerd since the late 20th century, she’s been 
entertaining and educating aspiring pixel pushers for nearly 20 
years, making Photoshop as easy to learn as it is fun.

When she’s not cooking up new tutorials, you might find her 
among the debris of   her craft room, catching up with her 
favorite late night hosts, or training for a marathon.

Find Khara and grab her free Creative Toolkit for Photoshop 
at: kharaplicanic.com

MEET YOUR
INSTRUCTOR

CLICK HERE TO DOWNLOAD
YOUR FREE CREATIVE TOOLKIT!

https://kharaplicanic.com
https://kharaplicanic.com/freebies
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DIRTY TYPE
Did you know that you can create a path from type—and stroke 
it with a brush? The creative applications are limitless and it’s 
easier than you think!

1. License the source files and activate the fonts. For 
this project, we’ll be using this image of  soil and this 
scene setting image from Adobe’s free stock collection. 
 
From Adobe’s font collection, activate the Marydale and 
Salvation typefaces included with your CreativeCloud 
subscription.

2. Add a type layer that says, “DIRT.” Using the Type 
tool (T), click to create a point type layer, then set the 
word DIRT using the Salvation typeface at a size of  
245pts. (Don’t worry about the font color as it will all be 
covered with the dirt image shortly.)

3. Create a work path from the type, add a new blank 
layer. In the Layers panel (Window > Layers), right-
click in an empty area next to the dirt layer’s name and 
choose Create Work Path to build a path from the 
shape of  the text. Then, click the  icon from the 
bottom of  the Layer’s panel to create a new, blank layer

4. Load Kyle T Webster’s Scatter and Concept brush 
packs. Select the Brush tool (B), and from the Brush 
panel, click the cog wheel and select, Get More 
Brushes. From the web page that opens, download 
the Scatter and Concept brush packs, then double-click 
to open and load them into Photoshop. (If  for some 
reason they’re not automatically installed, you can return 
to the Brush panel, click the cog wheel and choose 
Import Brushes. Then navigate to the two brush packs 
and select them to add them to your Brush panel.)

5. Create a blank layer, choose a brush and stroke the 
path. Create a new blank layer and in the search bar at 
the top of  the Brush panel, type the word “etching” 
and select the Etching Dirty brush from Kyle’s Spatter 
Brushes and set the size to 90px. In the Paths panel, 
right-click an empty area next to the name “Work Path” 
and choose Stroke Path. Select Brush from the Tool 
and make sure Simulate Pressure is unchecked. Click 
OK.

https://stock.adobe.com/images/texture-of-a-universal-soil-with-mineral-fertilizers-for-planting-flowers-and-plants/246801380
https://stock.adobe.com/images/gardening-background-with-garden-tolls/349135830
https://fonts.adobe.com/fonts/marydale
https://fonts.adobe.com/fonts/salvation
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6. Repeat with another new layer and a second brush. 
Create a second blank layer, choose the Texture Pop 2 
brush from Kyle’s Concept brush pack, and set the size 
to 40px. In the Paths panel, click to activate the work 
path in the Paths panel, and right-click to select Stroke 
Path, just as before.

7. Group the dirt layers, paste in the soil image, and 
clip it to the group. With the top layer selected, hold 
Shift and click the dirt layer to select all three layers 
(except the Background). Press Cmd/Ctrl + G to 
group them. 
 
Switch focus to the soil image and press Cmd/Ctrl 
+ A to select all, then Cmd/Ctrl + C to copy. Return 
to the work in progress image and press Cmd/Ctrl + 
V to paste in the soil image. Press Cmd/Ctrl + T to 
bring up Free Transform, then scale the soil by dragging 
inward from a corner until it covers just the first two 
letters. 
 
Duplicate the soil layer by pressing Cmd/Ctrl + J and 
use the Move tool (V) to drag the duplicated soil layer 
to the right, covering the remaining two letters. Press 
Cmd/Ctrl + E to merge the duplicate soil layer with 
the first soil layer. Rename the layer “soil” by double-
clicking the existing name, entering the new name and 
pressing Enter. 
 
In the Layers panel, drag the soil layer directly above the 
grouped layers and clip it to the grouped folder below 
by choosing Layer > Create Clipping Mask.

8. Add a drop shadow to the grouped layers. In the 
Layers panel, target the grouped folder and click the  
button at the bottom and select Drop Shadow. Set 
the Blend Mode to Multiply, the Opacity to 75%, the 
Angle to 120, and the Distance to 25px, then click OK.

9. Finish with an additional type layer. Add a second 
type layer that says, “Of  all the paths you take in life, 
make sure a few are” using white text. Choose the 
Marydale typeface and set the size to 29pts. 
 
Add levels adjustment layers as desired to increase the 
contrast between the soiled letters and the background.
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OPEN TYPE + CUSTOMIZATION
If  you’re not familiar with the features that make the open 
type font format so incredible—prepare to have your mind 
blown! After exploring a great example of  a well coded font, 
we’ll transform the whole thing into a shape and learn how to 
customize the letter forms for unlimited typographic potential!

1. Gather the project files and typefaces. In this project, 
we’ll be using this coffee cup image from Adobe Stock’s 
free collection along with the utterly brilliant Filicudi 
collection from the Tipoteca Series by Ulrike Rausch 
for Adobe Fonts (both are free with your CreativeCloud 
subscription).

2. Create a blank slate and explore! Before we dive into 
the project, let’s take a minute to explore and appreciate 
the brilliant use of  open type features in this typeface 
collection. 
 
Open the coffee image and from the bottom of  the 
Layers panel, click the  icon, select Solid Color, set 
the color to white and click OK. This gives a temporary 
clean slate to experiment with. 
 
Next, use the Type tool to create a new type layer and 
choose the Filicudi Color Pride typeface. Type the word 
PARTY and as you type, notice that the colors of  the 
stripes are repeating in order—despite the fact that 
the number of  stripes per letter varies. This happens 
because the open type format allows designers to not 
only include multiple versions of  each letter (potentially 
as many as 65,000 characters!), but also to program 
certain behaviors into the font, including a feature 
known as “Contextural Alternates.”  
 
The stripes in this font maintain their color pattern 
because the designer included multiple versions of  each 
letter, each beginning with a different colored stripe—
and—coded the font in such a way that it automatically 
selects the appropriate version of  each letter based on 
the stripe color the preceding letter ends with. Pretty 
amazing, right? 
 
You can toggle this feature on and off  in a variety of  
places, including from the menu by choosing Type > 
Open Type > Contextural Alternates.

https://stock.adobe.com/images/paper-cup-and-coffee-beans-on-cement-floor-background/305678866
https://fonts.adobe.com/fonts/tipoteca-series
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3. Trash both the adjustment and type layers for a 
fresh start. Drag the PARTY type layer to the trash 
along with the solid color adjustment layer and use the 
Type tool to create a new type layer. With black as your 
text color, this time, choose the Filicudi Striped font and 
set at 140pts. Type COF then hit Return and type FEE 
on the second line. In the Control panel, make sure the 
paragraph alignment is set to centered.

4. Duplicate the type layer and convert it to a shape. 
With the type layer selected, press Cmd/Ctrl + J 
to duplicate the layer, then hide the original layer by 
clicking the “eye ball” to the left of  the layer thumbnail. 
(This way we have an editable backup copy of  our type 
even after we lose the ability to edit the text.) 
 
Click to target the text copy layer, then right-click (or 
Ctrl-click) and select Covert to Shape. This turns the 
text into editable vector outlines—which ironically 
means we can no longer make changes to the text itself  
(like changing what it says or fixing a spelling error) nor 
can we change the font at this point.

5. Select the various anchor points, edit as needed, 
then convert to smart object. Using the Direct 
Selection tool (A), click away to deselect the entire path, 
then marquee select over the bottom two anchor points 
of  the top stripe on the far right to select them. (They 
should appear with a blue fill while the other anchor 
points are hollow.) 
 
Hold the Shift key and drag downwards until the anchor 
points align with the bottom of  the stripes in the second 
row. Repeat on the left side.

6. Transform, distort, and warp. With the smart object 
layer selected, press Cmd/Ctrl + T to bring up Free 
Transform. Move the type into position on top of  the 
coffee cup and scale to an approximate size—but don’t 
commit the transformation yet. 
 
Right-click (or Ctrl-click) inside the transform bounding 
box and select Distort from the sub-menu. Drag each 
of  the corner points to align with the cup—again, don’t 
commit yet. 
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Right-click (or Ctrl-click) once again inside the 
transform bounding box again, and this time choose 
Warp. Adjust the handles to fit the top and bottom 
edges along the curve at the top and bottom of  the cup. 
When satisfied, press Return/Enter to commit the 
transformation.

7. Select and Mask to the cup. In the Layers panel, 
temporarily hide the shape layer, select the Background 
layer, and use the Quick Selection tool (W) to select the 
brown section of  the coffee cup. 
 
Again in the Layers panel, click to re-activate the shape 
layer, and add a mask by choosing the  icon at the 
bottom. 
 
Finally, change the shape layer’s blend mode to multiply.
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FANCIFUL TYPE
How do you know what kinds of  cool features your fonts might  
be hiding? The answers can be found in several places, you just 
have to know where to look!

1. Gather project files. In this project, we’ll be using this 
illustration of  a cat (courtesy of  Adobe Stock’s free 
collection) and the typeface trio known as Looking 
Flowers from Adobe Fonts.

2. Reformat by cropping to a square. Press (I) for the 
Eyedropper tool and sample the yellow background in 
the image. Press (X) to e(x)change your foreground and 
background swatches so the sampled yellow color is in 
the back. Finally, press (C) for the Crop tool and select a 
1:1 ratio from the drop down in the Control panel, and 
make sure Delete Cropped Pixels is enabled. 
 
Drag the bottom right corner down and to the right 
until the crop aligns with the bottom of  the image. 
Then drag the top right corner up and to the right until 
you’ve enlarged the canvas to the point where there’s 
a large chunk of  negative space to hold the type we’re 
about to create. 
 
Commit the crop by pressing Return/Enter.

3. Add the four main type layers. Use the Type tool 
(T) to create a text layer with the words “Le chat” in 
Looking Flowers Caps at a size of  around 615pts. 
Commit the type by pressing Cmd/Ctrl + Return/
Enter. 
 
Using the same settings, create a second type layer that 
says, “est” and a third that says, “sur” (the reason for 
keeping these two words in separate layers will become 
clear soon). 
 
Finally, create a fourth type layer with the words, “la 
chaise,” then commit the type by pressing Cmd/Ctrl + 
Return/Enter. 
 
Looking good! Now we’re ready to get fancy and really 
see what kinds of  treasures a font might contain!

https://stock.adobe.com/images/black-cat-sitting-at-chair-with-hanging-face-patterned-towel/475612179
https://stock.adobe.com/images/black-cat-sitting-at-chair-with-hanging-face-patterned-towel/475612179
https://fonts.adobe.com/fonts/looking-flowers
https://fonts.adobe.com/fonts/looking-flowers
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4. Take advantage of  stylistic alternates to add flair. 
In the first type layer, select the “Le” in Le chat and 
change the font to Looking Flowers Script. Then, 
highlight the “L” and notice the fly-out menu that 
appears, displaying the stylistic alternates available. To 
swap one style of  L for another, simply click to select it 
from the menu. 
 
Next, select the “e” in Le and notice the alternate 
options. While the e in the top right of  the fly-out menu 
is lovely, it’s best suited for when the letter appears at 
the beginning of  a word as, in this case, the long flourish 
would push the L too far away. The bottom e, while 
beautiful, crashes with the fancy L we’ve just selected. 
As with most things in life, moderation and balance 
are key, so in this case, let’s just stick with the default 
version of  the e. 
 
Moving down to the type layer that reads, “la chaise,” 
select the “la” and again, change the font to Looking 
Flowers Script. Highlight the lowercase “l” and choose 
whichever alternate you prefer before turning your 
attention to the lowercase “a.”   

In my example, I chose the ª version and decided it felt 
a bit cramped with the l so I inserted my cursor between 
the “l” and the “a” and in the Character panel (Window 
> Character), I increased the kerning to 50 to give the 
“a” some more room to breathe. I also adjusted the 
space between the c in “chaise” and the space character 
in front of  it to snuggle it closer to the word “la,” 
choosing a kerning value of  -160. Finally, I selected the 
word CHAISE and applied a baseline shift of  182pts. 
 
Next, target the EST type layer and with the Type tool 
active, click the  icon in the Control panel to bring up 
the Warp Text options. Select Rise for the Style, leave 
the radio button set to Horizontal, and set the Bend to 
a mild 15% before clicking OK. And though we’ll keep 
the font as it is (Looking Flowers Caps), reduce the size 
to 410pts. (You’ll see why in the next step.) 
 
Finally, select the SUR type layer and change the font to 
Looking Flowers Script.
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5. Get to know the Glyphs panel! Our text is 
looking good— but there’s a whole lot more 
fun to be found within this typeface! If  you 
select one of  the script characters again to 
bring up the fly-out menu with the stylistic 
alternates,  you may wonder what happens if  
you click on the little triangle arrow pointing 
to the right? (Hint: It opens the Glyphs 
panel!) 
 
With the Type tool, click an empty area of  
the image (away from existing type) to create 
a new, blank text layer and with the cursor 
active, open the Glyphs panel by choosing 
Window > Glyphs.  
 
At the top of  the Glyphs panel, select the 
Looking Flowers typeface from the first 
drop down, and the Deco version of  the 

font from the second. Below that, make sure 
the third drop down is set to Entire Font. 
Use the  icons at the bottom of  the 
panel to scale the thumbnail preview up or 
down so you can see them comfortably. 
 
Here we can see every single character 
the Deco version of  the Looking Flowers 
typeface has to offer. Browse through the 
options until you find the scrolled banner 
that looks like , then double-click to 
insert it at the active cursor in the blank type 
layer we just created. Set the size to 410pts,  
and use the Move tool (V) to position the 
banner so that it surrounds the EST text.  
 
Press Cmd/Ctrl + Return/Enter to 
commit the type.
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6. Add the finishing touch with a few ornamental 
dingbats. Create another blank type layer by clicking 
in an empty area of  the design with the Type tool. With 
the cursor active, set the size to 400pts and open the 
Glyphs panel. 
 
Locate the  dingbat (2nd from the top) and double-
click to insert it into the design. Commit the type and 
use the Move tool (V) to position it below the word 
“CHAISE.” 
 
Next, create another blank type layer, set the size to 
785pts and in the Glyphs panel, find the Rdingbat 
and click to insert it. Use the Move tool to position the 
hearts to the upper right of  the word “sur.” 
 
Finally, create yet another blank type layer, set the font 
size to 585 pts and insert the  t glyph. Position it to 
the left of  the “EST” text then press Cmd/Ctrl + J 
to duplicate the layer and Cmd/Ctrl + T to bring up 
Free Transform. Scale the duplicated glyph down and 
position as desired alongside the larger version. 
 
Press Cmd/Ctrl + J again to make one more copy and 
move it into position, creating a small cluster of  all 
three t glyphs. 
 

EXTRA CREDIT
For an added bonus, using what you’ve learned in this project 
and the previous one, experiment with the other available glyphs 
in the Looking Flowers Deco font to create this fun border 
around the image. 
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